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PREFACIO

Uno de los motivos que me llevaron a realizar este trabajo fue la
importancia de la ciencia de la mecanica en el desarrollo tecnolégico de la
humanidad. Se puede estudiar la historia de la humanidad a través de los
instrumentos, herramientas y maquinaria que se han construido para
diferentes propdsitos: buscar el alimento a través de la caza, mejorar los
procesos agricolas, fabricar vestimenta adecuada a la regidon, construir
vivienda y edificios, enfrentar al enemigo en la guerra, transportar, navegar,
producir un determinado bien o servicio, etc. También me motivd el hecho
de que todavia hay espacio para experimentar con nuevas ideas y que la
sociedad guatemalteca puede aprovechar el conocimiento ya existente sobre
la ciencia de la mecanica y utilizarla para crear o modificar tecnologia, de tal
manera que el resultado esté a su alcance econdmico y social, y su desarrollo
sea sostenible.

Este trabajo busca introducir al lector en la resolucién de problemas de
mecanismos de maquinaria a través de programas informaticos que permiten
visualizar, simular y obtener resultados antes de construir costosos prototipos
o modelos reales. Existen diferentes opciones a elegir sobre el tipo de
programa informatico pero para este trabajo utilicé Autodesk Inventor
Professional 2008 porque estd disponible en la Universidad del Valle de
Guatemala y porque actualmente se imparte un curso dentro del pénsum de
la carrera de Ingenieria Mecanica que se basa en el mismo programa.

Finalmente, espero que este trabajo motive a otros estudiantes y
disefadores a publicar su conocimiento y compartirlo con el afan de
colaborar con la construccién de una mejor sociedad de ingenieria aplicada

en Guatemala y el mundo entero.
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RESUMEN

Este trabajo es una guia para la resolucion de problemas de
mecanismos a través de la construccién de prototipos CAD (Computer Aided
Design) y su contenido estd distribuido en tres partes fundamentales: La
primera es una referencia tedrica a los conceptos de dindmica y mecanismos
mas importantes. La segunda es una referencia practica al programa
Inventor Professional 2008 con los procedimientos mas importantes en la
resolucidn de problemas de simulacién dinamica Finalmente, la tercera

consiste en la resolucién de un ejemplo de mecanismo.
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I. INTRODUCCION

Para analizar el comportamiento de los mecanismos, la ciencia de la
Mecanica utiliza los conceptos de dinamica, que a su vez se subdivide en
cinematica y cinética aplicada a cuerpos rigidos. La cinematica se encarga de
estudiar el movimiento de los cuerpos sin considerar la masa de los mismos,
asumiendo que su comportamiento es similar al de una particula; la cinética
toma en cuenta la masa de los objetos para determinar las fuerzas que
actlan sobre las uniones y cualquier punto dentro de los objetos. A partir de
la dindmica de los cuerpos rigidos y las propiedades del material es posible
determinar la resistencia de los cuerpos ante tales condiciones de
funcionamiento. Existen muchas técnicas para la sintesis de mecanismos,
desde modelos tedrico-matematicos hasta la construccidn real de un modelo
a escala y mediciones de laboratorio. El primero requiere un alto grado de
habilidad matematica para realizar modelos tedricos y de igual manera deben
suponerse situaciones para aproximarse a la realidad; el segundo requiere
grandes inversiones de tiempo y dinero que afecta directamente el precio y
tiempo de lanzamiento de los productos.

Es por eso que en este trabajo se introduce un programa conocido
como Autodesk Inventor Professional 2008, que se encuentra disponible a
nivel comercial y educativo, y en el cual se realizaran prototipos virtuales con
condiciones de simulacion dinamica.

Para aplicar las funcionalidades del programa referente a |la
construccién y simulacion de prototipos de mecanismos se estableceran
procedimientos y se presentaran ejemplos con el objetivo de guiar al lector
en el uso del programa en esta aplicacion en particular.

Finalmente se obtendran prototipos virtuales de mecanismos con
informacidn de posicidn, velocidad, aceleracidon y fuerzas a través de datos y

graficas generadas desde el mddulo de simulacién dinamica.



II. FUNDAMENTOS DE MECANISMOS

Para entender el concepto de mecanismo es necesario conocer dos
ciencias fundamentales y aclarar su relacién con el concepto de maquina.
En la practica ambos conceptos son dependientes uno del otro y han
estado involucrados en el desarrollo de la humanidad de manera

fundamental.

A. Cinematica y cinética

La cinematica tiene su origen del griego kinéma, kinématos®' que
significa movimiento; el conjunto de mecanismos en movimiento, sin
referencia alguna de fuerzas o masas. Por otro lado, la cinética tiene su
origen del griego kinétikos, que se refiere al resultado de un movimiento, y
es la ciencia que estudia el movimiento de las masas en relacién a las fuerzas
gue actuan sobre ellas. Ambas ciencias forman parte de la dinamica, que
es la parte de la mecanica que se encarga del andlisis de los cuerpos en

movimiento.

B. Mecanismos y maquina

Un mecanismo es una combinaciéon de piezas conectadas entre si que
producen un movimiento relativo predeterminado que al considerar la masa
de las piezas y las fuerzas que actian sobre ellas puede ser una maquina o
parte de la misma, con la caracteristica principal que realiza trabajo
mecanico. Tedricamente todos los mecanismos que se construyen tienen
masa y estan sujetos a fuerzas externas para realizar un trabajo mecanico,
pero debido a que las fuerzas que transmiten no son significativas, muchos

de ellos son analizados Unicamente por las leyes de la cinematica.

1 Webster's New World Dictionary, Encyclopedic Edition, page 805



El limite entre aquello significativo y no significativo ha sido
determinado por la propia percepcion de los inventores y usuarios a través de
la historia. Por ejemplo, el mecanismo de una sombrilla, a pesar de ser un
mecanismo sencillo y no ser considerado maquina, requiere para su disefio y
dimensionamiento consideraciones de masa y resistencia de materiales, para
poder realizar un trabajo al abrirse luego de aplicarle una fuerza externa.

Asi mismo pueden citarse otros ejemplos tales como, valvulas de paso,
parabrisas de vehiculo, bisagras de puerta, el mecanismo de suspensién y

otros, los cuales consideramos popularmente como mecanismos puros.



III. FUNDAMENTOS DE CINEMATICA

La cinematica se puede analizar desde dos puntos de vista, cinematica
de particulas y cinematica de cuerpos rigidos. El estudio de mecanismos se
enfocara hacia el segundo punto de vista.

A diferencia de la cinematica de particulas, la cinematica de cuerpos
rigidos si considera el analisis de los movimiento respecto al centro de

gravedad de los cuerpos.

A. Movimiento de mecanismos

Es el cambio de posicién de un cuerpo relativo a otro considerado fijo.
En este caso de estudio, se considerara que por lo menos algun elemento

del mecanismo es fijo.

1. Trayectoria. Algun punto dentro de un elemento en
movimiento describe una linea denominada trayectoria, la cual puede ser

rectilinea o curvilinea.

2. Direccion y sentido. Se considerara la convencién de
signos internacional aceptada. Es decir, direccion hacia la derecha (+), hacia
la izquierda (-) hacia arriba (+) y hacia abajo (-), y sus respectivas
combinaciones de acuerdo a las propiedades vectoriales del movimiento, asi
como el giro contrario a las agujas del reloj (+) y el giro a favor de las agujas

del reloj (-).
B. Tipos de movimiento

Se consideraran tres tipos de movimiento basicos: rotacion, traslacion

y complejo (producto de una combinacion de las anteriores).



1. Rotacion alrededor de un eje fijo. El elemento posee un
eje de rotacion y la trayectoria de cualquier punto del elemento es un arco

total o parcial, a excepcion de los puntos localizados sobre el eje de rotacion.

2. Traslacion. Se dice que un cuerpo estd en traslacién si
cualquier linea recta de un cuerpo permanece en la misma direccién durante
el movimiento, es decir, todos los puntos del cuerpo describen trayectorias

paralelas curvas o rectas.

3. Movimiento plano. Se identifica de esta manera al
movimiento de traslacion en el cual sus puntos describen especificamente

trayectorias rectas, sobre un plano particular.

4. Movimiento con respecto a un punto fijo. Es un
movimiento tridimensional de un cuerpo rigido respecto a un punto fijo, un

ejemplo de este movimiento es el de un trompo sobre un punto fijo.

5. Movimiento complejo. Es la combinacion simultéanea de
rotacion y traslacion que produce diferentes movimientos.? Sin embargo, en
el disefo de mecanismos se considera conveniente clasificar el movimiento
de acuerdo a la aceleracidon del elemento. Esta clasificacion depende del

valor de la aceleracion:

e Aceleraciéon nula
e Aceleracion constante

e Aceleracion variable

6. Movimiento uniforme (plano o de rotacion). <<Cuando
la aceleracion es nula, la velocidad es constante y la particula en movimiento

se mueve en una linea recta durante iguales distancias en iguales intervalos

2 El movimiento complejo en un mecanismo regularmente se encuentra en el elemento
acoplador, la curva del acoplador es la trayectoria de algln punto del elemento acoplador y
suele ser la caracteristica mas importante dentro del disefio del mecanismo.



de tiempo>>3. La grafica de posicion es una linea recta con pendiente y la
grafica de velocidad es una linea paralela al eje del tiempo, finalmente la

aceleracion es cero.

7. Movimiento uniformemente acelerado o retardado.

Si la velocidad es no uniforme, pero la aceleracién es constante, el punto
tiene un movimiento uniformemente acelerado, la aceleracién puede ser
negativa o positiva. La grafica de posicién es una parabola y la grafica de
velocidad es una linea recta con pendiente, finalmente la grafica de

aceleracion es una linea paralela al eje del tiempo.

8. Movimiento armonico simple. Se conoce como
movimiento armédnico simple a un tipo de movimiento en el que la
aceleracion vara directamente con el desplazamiento. El ejemplo mas comun

es el movimiento del péndulo sujeto a la gravedad.

9. Movimiento combinado. Este movimiento se puede
descomponer en tres fases. La primera fase corresponde a un movimiento
acelerado hasta un tiempo determinado, a partir del cual la segunda fase es
un movimiento uniforme hasta que un tiempo después el movimiento es

desacelerado hasta el final de la trayectoria.

3 Elementos de mecanismos, Doughtie, V & James, W., Traduccion al espanol por CECSA,
lera. publicacién. Pagina 35



IV. FUNDAMENTOS DE CINETICA

Para comprender los principios de la cinética es conveniente recordar
la primera, segunda y tercera ley de Newton, en especial atencién a la
segunda ley de Newton que relaciona la cinematica con la masa de los

cuerpos rigidos.

A. Leyes de Newton
Las leyes se pueden resumir de la siguiente manera:

e Todo cuerpo se mantiene en estado de reposo o en movimiento
uniforme en una linea recta, hasta que se le aplique una fuerza.

e La aceleracion de un cuerpo es proporcional a la fuerza que actla
sobre el mismo, y toma lugar a lo largo de la linea de accion de dicha
fuerza.

e Todo cuerpo bajo una fuerza de acciéon provoca una fuerza de reaccidon

de igual magnitud y de direccién opuesta.

B. Momento inercial

<<El momento de inercia o inercia estacional es una magnitud
que da cuenta de como es la distribucion de masas de un cuerpo o un
sistema de particulas alrededor de uno de sus puntos. En el movimiento de
rotacion, este concepto desempefia un papel andlogo al de la masa inercial
en el caso del movimiento rectilineo y uniforme. Representa la inercia de un

cuerpo a rotar*>>.

4 http://es.wikipedia.org/wiki/Momento_de_inercia#Definici.C3.B3n_de_momento_de_inerci
a



C. Principio de d'Alembert

Las fuerzas externas que actluan sobre un cuerpo rigido son
equivalentes a las fuerzas inerciales de las diversas particulas que forman el
cuerpo, y pueden sustituirse por un vector fijo al centro de masa del objeto y
un par de momento inercial.

El principio de d'Alembert, enunciado por Jean d'Alembert_en su
obra maestra, El tratado de dinamica establece que la suma de las fuerzas
externas que actlan sobre un cuerpo y las denominadas fuerzas de inercia
forman un sistema de fuerzas en equilibrio. A este equilibrio se le denomina

equilibrio dinamico.



V. CONSIDERACIONES SOBRE MECANISMOS

A. Grados de libertad

Grados de libertad (Degrees of Freedom, DOF, por su siglas en inglés)
es el NUmero de variables que se necesitan para definir la posicién de un
cuerpo rigido en cualquier instante en particular, con respecto a un marco de
referencia determinado. Por ejemplo, un cuerpo en el espacio tridimensional
tiene 6 GDL, los cuales son, posicién x,y,z para ubicar el centro de gravedad,
y tres angulos alfa, beta y gama para definir la direccidn de cualquier punto

del cuerpo rigido.®
B. Eslabones, uniones y cadenas cinematicas

1. Eslabon. Es un cuerpo rigido que posee al menos dos nodos,
gue son los puntos de unién con otros eslabones. Los eslabones pueden

clasificarse en:

e Eslabdn Binario (2 nodos)
e Eslabdn Ternario (3 nodos)
e Eslabdn Cuaternario (4 nodos)

2. Junta o union. Es el tipo de conexidon que ocurre entre
eslabones que puede o no permitir movimiento relativo. Se pueden clasificar

de acuerdo a:

e El tipo de grados de libertad permitidos por la unién

e El tipo de contacto entre los elementos: de linea, de punto, de
superficie.

e El tipo de cierre de la unién, de fuerza o de forma

e ElI Numero de eslabones conectados (orden de la union)

5 Para mayor ejemplificacion sobre el concepto de grados de libertad se recomienda la
lectura del capitulo 2 de libro Disefio de Maquinaria de Robert L. Norton, primera edicién en
espanol.
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3. Cierre de forma y de fuerza. Una unioén es de cierre de
forma cuando se mantiene unida por la geometria cerrada, tal es el caso de
un pasador en su agujero o una corredera con ranura o guia en la parte
superior e inferior. Una unidn es de cierre de fuerza cuando necesita de una
fuerza externa para permanecer en contacto. Estas fuerzas pueden ser la
producida por la gravedad o por el accionamiento de un resorte. En los
eslabonamientos regularmente se prefiere cierre de forma, pero para levas

regularmente se utiliza cierre de fuerza.

4. Orden de la unidon. El orden la unidn se define como el

NUmero de eslabones conectados en una misma unién, menos uno.

5. Manivela. Es un eslabon que efectia una vuelta completa o

revolucién, y esta pivotada a un elemento fijo.

6. Balancin. Un eslabdn que tiene rotacion oscilatoria y esta

pivotado a un elemento fijo.

7. Biela o acoplador. Un eslabén que tiene movimiento

completo y que no esta pivotado a un elemento fijo.

8. Fijador o elemento fijo. Cualquier eslabén o conjunto de
eslabones que no se encuentran en movimiento en relaciéon con el marco de

referencia.

9. Cadena cinematica. <<Es un ensamble de eslabones y
uniones, conectados de modo que proporcionen un movimiento de salida

controlado en respuesta a un movimiento de entrada proporcionado®>>.

6 Disefio de Maquinaria de Robert L. Norton, primera edicién en espafiol. Pagina 29
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Tabla No.1 Tipos de uniones y sus caracteristicas
Nombre Tipo Caracteristicas
Junta de pasador|Junta Un grado de libertad de primer orden
para rotacion (con|completa
cierre de forma)
Junta de corredera|Junta Un grado de libertad de primer orden
para traslacion (con|completa
cierre de forma)
Eslabdn apoyado | Semijunta Dos grados de libertad de primer orden
contra un plano
(con cierre de
fuerza)
Eslabdn con | Semijunta Dos grados de libertad de primer orden
pasador en ranura
(con cierre de
forma)
Junta de rétula (o|Semijunta Tres grados de libertad de primer orden
de bola)
Junta de pasador|Semijunta Dos grados de libertad de segundo orden
(con cierre de
forma)
Junta de|Semijunta Puede rodar, deslizar o rodar y deslizar, segun
rodamiento (junta la friccion, con uno o dos grados de libertad.
de fuerza)

C. Determinacion del grado de libertad

<<Una cadena cinematica, el grado de libertad es el Numero de

condiciones que se necesitan proporcionar a fin de lograr un movimiento de

salida predecible’>>.

Estas condiciones pueden ser variables de posicidn,

velocidad o aceleracién de alguno de los elementos del mecanismo que sea

considerado como elemento propulsor del movimiento.

7 Disefio de Maquinaria de Robert L. Norton, primera edicidén en espafiol., pagina 29
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D. Diferencia entre mecanismos y estructuras

Los grados de libertad de un ensamble de eslabones predicen por
completo su caracter. Hay uUnicamente tres posibilidades. Si el GDL es
positivo se tendra un mecanismo, y los eslabones tendran movimiento
relativo. Si el GDL es exactamente igual a cero, entonces se tendra una
estructura y ningln movimiento es posible. Si el GDL es negativo, entonces
se tendra una estructura pre cargada, que no permite el movimiento y que

contiene esfuerzos presentes en la estructura.



VI. TIPOS DE MECANISMOS

A. Mecanismos de cuatro eslabones o barras

Los mecanismos de cuatro eslabones son los mas utilizados en el
disefio de maquinaria por ser simplificados en su analisis y control. Son
utilizados en aplicaciones muy comunes como en motores de combustién
interna, en el mecanismo de direccién de un automoévil, en un sistema de
bombeo de agua manual, un pantégrafo copiador o escalador de plantillas de
corte en ldmina, un sistema de reglas paralelas, el mecanismo de transmision
de potencia de ruedas de ferrocarril, el brazo articulado y amortiguado de
puertas en edificios y buses urbanos, en el mecanismo de suspensiéon de un
automoévil, etc. Los mecanismos de cuatro barras regularmente estan
formados por un bastidor fijo, una manivela, un elemento acoplador y un
balancin o corredera. Cada uno de ellos se dimensiona de tal manera que se

cumpla con la condicién inicial de Grashof.

1. Condicion de Grashof. Es una relacidon que pronostica el
comportamiento de un mecanismo de cuatro eslabones considerando las

longitudes de cada eslabdn. Considerando:

S= longitud del eslabon mas corto
L= longitud del eslabén mas largo
P= longitud de un eslabon restante

Q= longitud de otro eslabon restante, entonces:
S+L<=P+Q
Cumpliendo con esta condicién, al menos un eslabdn (el méas corto)
sera capaz dar una revolucién completa con respecto al bastidor. Si esta

desigualdad no se cumple, entonces es un mecanismo es no-Grashof y

13
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necesita de eslabones adicionales para funcionar de manera continua. Tal es
el caso de mecanismos de cinco y seis barras que se utilizan en ocasiones
especiales y que producen movimientos especiales utilizados en maquinaria
como mortajadoras horizontales o cepillos industriales para arranque de

viruta en metales.

2. Mecanismos de cinco y seis eslabones o barras. Los
mecanismos de cinco o seis eslabones se utilizan en aplicaciones especiales y
normalmente se forman de un eslabdn de cuatro barras que no cumple con la
condicién de Grashof conectado desde uno de los balancines con un par

articulado de manivela-acoplador que si cumple con la condicidon de Grashof.

B. Curvas de acoplador

El acoplador es el eslabon méas importante en cualquier mecanismo. Su
movimiento es complejo y produce trayectorias de formas especiales. Estas
trayectorias simulan el movimiento real. En el disefio de mecanismos, se
recomienda buscar en un atlas de acoplador la curva que mas se asemeje al
movimiento deseado en la maquinaria, regularmente estos documentos
tienen las proporciones de la longitud de los eslabones para su construccion.
Estos son algunos ejemplos de curvas de acoplador resultantes de un
mecanismo de cuatro barras, especificando la trayectoria de un punto del

acoplador 8.

8 Disefio de Maquinaria de Robert L. Norton, primera edicién en espafiol., pagina 97



VII. MECANISMOS UTILIZADOS EN LA
MAQUINARIA

A. Mecanismo de manivela-balancin

Descripcion: Este mecanismo es de 4
eslabones, estda formado de manivela “a”,
acoplador “b”, balancin “c”, bastidor (0204,
fijo). El mecanismo tiene un grado de

libertad, es decir, solamente se necesita

un valor del angulo 6, para definir la
posicion de los siguientes eslabones.
&.j{:‘.ﬁ;- Ademds, para que la manivela gire

&P [ completamente deberd cumplir con la
condicion de Grashof. Una gran
diversidad de maquinas utilizan

mecanismos de manivela balancin. En la

imagen se muestra una maquina conocida como “la eliptica” utilizada como

equipo de entrenamiento personal.

15
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B. Mecanismo de manivela-corredera

Descripcion: Este mecanismo es
de cuatro eslabones, esta formado

A\ n”

de manivela “a”, acoplador "“b”

corredera “c”, bastidor (0204,
fijo). El mecanismo tiene un
grado de libertad, es decir,
solamente se necesita un valor del

angulo 82 para definir la posicidn

de los siguientes eslabones.
Ademads, para que la manivela gire completamente deberd cumplir con la
condicién de Grashof, tomando en cuenta que la longitud de la corredera sera
mayor que la longitud de la manivela. La aplicacién mas conocida es aquella
gue ocurre dentro de un motor de combustién interna; la presion resultante
de la combustion que se ejerce sobre el pistdn (corredera) se transmite a
través de la biela (acoplador) hacia el cigliefal (manivela). En este
mecanismo un movimiento lineal tiene como salida un movimiento angular.
Aplicaciones similares, como la de un compresor reciprocante, difiere de la
del motor de combustidn interna por el lugar donde se aplica la fuerza; en

este caso, un movimiento angular provoca un movimiento lineal de salida.
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C. Mecanismos para movimiento de linea recta

/

)

Este eslabonamiento es parte de un
mecanismo de linea cuasi-recta
de Watt, en este caso los
eslabones “a” y “c” son balancines
de la misma longitud, vy el
eslabonamiento “b” es acoplador.
Este mecanismo es de un grado de

libertad, su posicidon depende del

valor del angulo de alguno de los
balancines. Notar que el eslabdn fijo es de mayor longitud que la longitud de
los balancines y que no cumple con la condiciéon de Grashof. Para que
funcione de manera continua de ida y retorno, seria necesario afadir dos
eslabonamientos adicionales que se conectan entre si, con uno de los
extremos conectados a un eslabonamiento fijo y otro hacia alguno de los
balancines; lo que haria un eslabonamiento de seis barras. Fue inventado
por James Watt (1736-1819) para restringir el movimiento de un motor de
piston de vapor respecto a una linea recta. La trayectoria generada no es
una recta formal, pero se asemeja lo suficiente como para considerarsela
para aplicaciones reales. Este mecanismo se usa con frecuencia en los

sistemas de suspension de los automoviles, para guiar el eje trasero hacia
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arriba y abajo en linea recta. En la imagen se muestra el eje trasero de un

vehiculo con el mecanismo de linea cuasi-recta de Watt.

Este eslabonamiento es parte de un mecanismo de linea cuasi-
recta de Chebyshev, en este caso los eslabones “a” y “c” son balancin, y el
eslabonamiento “b” es acoplador. Notar que si cumple con la condicién de
Grashof, el eslabén “b” dard al menos una revolucion completa. Las
proporciones necesarias para el funcionamiento correcto del mecanismo son:
d:a:b, como 2:2.5:1. Este mecanismo fue inventado por un matematico
ruso Pafnuty Chebyshev (1821-1894) en una época en la que se buscaba un
mecanismo que transformara el movimiento rotatorio en movimiento lineal,

para aplicarlo al desarrollo de maquinas de vapor.
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Para generar una linea recta es necesario construir un mecanismo de
mas de cuatro barras. Uno de los mecanismos mas conocidos es el de
Peaucellier (1824), quien descubrié un mecanismo con movimiento de linea
recta exacto. Utilizando 8 barras, 4 de las cuales estdn son de la misma
longitud y estan unidas entre si formando un rombo. Los eslabones 3 y 4
son iguales, asi como también la distancia 0.0y la longitud del eslabon 2
tambien son iguales. El punto de union del eslabén 5 con el eslabdn 6 tiene
un movimiento resultante en linea recta. Haciendo pequefias variaciones
entre la distancia 0,04 y la longitud de eslabdén 2 es posible también obtener

como resultado trayectorias en forma de arco relativamente grandes.
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D. Mecanismos de retorno rapido

lenta y el retorno rapido.

Este eslabonamiento es un
mecanismo de retorno rapido; el
movimiento de la corredera se descompone en
dos movimientos diferentes: hacia un lado la
corredera “e” se desplaza lentamente y hacia el
otro lado se desplaza rapidamente. Este es el
caso de una maquina herramienta de arranque
de viruta conocida como mortajadora
horizontal, en la cual la carrera de corte es

En eslabén “a” gira completamente, asi que

cumple con la condicién de Grashof de un grado de libertad. EI mecanismo

queda definido por la posicién angular del eslabén “a” dentro de los 360° de

rotacion.



VIII. ELABORACION DE PROTOTIPOS VIRTUALES DE
MECANISMOS

A. Introduccion a Inventor Professional 2008

Inventor Professional 2008 es un programa informatico que integra
aplicaciones CAD (Computer Aided Design) con aplicaciones CAE (Computer
Aided Engineering) en la elaboracion de prototipos virtuales de maquinaria y
equipo. Es parte de la tercera generaciéon de programas informaticos CAD
y es producido por la empresa Autodesk, propietaria del programa AutoCAD.

Dentro de sus principales atributos estan:

e Modelado tridimensional de piezas

e Ensambles

e Presentaciones de ensamblaje y des ensamblaje
e Documentos constructivos

e Chapa metalica

e Simulacién cinematica y dindmica

e Anadlisis de Elementos Finitos

e Administracion de versiones de disefio

e Animacién y renderizado

En este estudio en particular se estara reforzando la creacion de partes
y ensambles, para luego aplicar el médulo de simulacidon dinamica. El mddulo
de simulacién dindmica opera Unicamente con archivos de ensamblaje (.iam).
Inventor Simulation utiliza la propiedades fisicas asociadas a cada parte, es
decir, masa, inercia y posicion del centro de masa. Todos las partes del
mecanismo inicialmente tienen cero grados de libertad, hasta que se

especifican las uniones entre eslabones se afiaden los grados de libertad
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correspondientes. Para simular el comportamiento dindmico de un
eslabonamiento (ensamble), es necesario definir las uniones mecanicas entre
los eslabones y adicional mente ubicar las fuerzas internas o externas que
actlan sobre ellos. Una vez esta creado el ensamblaje y activado el mdédulo
de simulaciéon dindmica, el ensamble puede considerarse un mecanismo.
Algunas de las restricciones estandar creadas en el ensamble pueden ser
interpretadas automaticamente por el moédulo de simulaciéon dinamica, este
sera el caso de los mecanismos que se estudiardn en este texto, sin
embargo, pueden definirse tipos de uniones especiales. En la siguiente tabla

se ilustran varios tipos de uniones disponibles en Inventor Professional 2008.

B. Moddulo de parte

El médulo de parte es muy versatil para la creacidn de piezas de
formas regulares e irregulares, aunque es importante recalcar que su
fortaleza es la creacién de piezas regulares, mayormente utilizadas en
maquinaria, debido a que uno de sus objetivos es mantener coherencia con

los procesos de ingenieria de la manufactura.

C. Modulo de ensamble

El médulo de ensamble se asemeja al proceso real de ensamblaje de
piezas. Este proceso se lleva a cabo a través del manejo de restricciones de
ensamble que controlan los grados de libertad del mecanismo. Normalmente

todas las piezas sin restricciones tendran 6 grados de libertad.

D. Modelos paramétricos

Un modelo paramétrico le permitira establecer un sistema de variables
de disefno, tales como ancho, alto, espesor, didmetro, etcétera; las variables
pueden ser compartidas con otras partes y ensambles dentro de un proyecto

en particular.
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Tabla No2. Uniones estandar disponibles en Inventor Professional 2008

v
4

Esférico Planar
Punto y linea linea y
plano
Punto y plano Espacial
V4
X
& 2
; Soldadura Revolucion
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Tabla No3. Uniones no-estandar disponibles en Inventor Professional 2008

Engrane y Engrane y
cremallera pifidn
Engrane
Engrane -Ng
: conico en
interno .
angulo
Engrane
Leva-rueda ng
. conico a
girando 900
Tangente a
Faja superficie

conica
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Continuacion Tabla No3. Uniones no-estandar disponibles en Inventor

Professional 2008

Union de Engrane_
tornillo sin
rosca .
fin
Rl.;(:;ia S(Ien Ruedas que
giro g deslizan
desliza
Rueda que
gira sobre Leva
superficie seguidor
interna de que desliza
otra rueda
De contacto
Punto y leva bidimension
al
De contacto
De resorte tridimension
al




IX. PROCEDIMIENTOS PARA LA SINTESIS DE
MECANISMOS EN AIP 2008

A continuacién se presenta el eje central de este trabajo que consiste
en una serie de diagramas de procedimientos y sus respectivas descripciones
de tal manera que puede servir de guia en la resolucidn de problemas de
disefio de mecanismos de barras o de otro tipo. Los procedimientos no son
Unicos para utilizar el programa Inventor Professional 2008 ya que depende
de la experiencia y la habilidad del disefiador para plantear las soluciones a
sus problemas particulares, sin embargo, pretenden guiarle de una manera
sencilla hacia la obtencion de resultados concretos y rapidos.

Antes de iniciar un proyecto de disefio de mecanismos de barras se
recomienda la creacidon de sketch a mano o en programas como AutoCAD a
manera de tener una solucidon previa. Esta preparacion permitird ahorrar
tiempo y esfuerzos en el proceso de modelar para el analisis en Inventor
Professional 2008.

También se recomienda considerar solamente aquellos elementos de
mecanismos que van a participar en el analisis para disminuir la carga sobre
los recursos de hardware disponibles.

Los procedimientos y la disponibilidad de Inventor Professional 2008
no eliminan en lo absoluto, la necesidad de que el disefiador se prepare en
los conceptos tedricos fundamentales para el acondicionamiento, preparacion
y analisis de los mecanismos. Un uso inadecuado o ilégico del programa
generara un error de la misma naturaleza.

Se recomienda realizar comprobaciones sobre los resultados graficos
con el calculo tedrico matematico con el objetivo de ejercer controles que le

den mayor factor de seguridad al analisis del disefo.
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1. Diagrama general de procedimiento para la sintesis de mecanismos en
Inventor 2008

Recopilar
informacion de
diseno
(1.1)

Modelar cada uno de
los eslabones
(1.2)

Ensamblar conjunto de
eslabones
(1.3)

Realizar analisis en
Simulacion Dinamica
(1.4)

i

Hay cambios

< Finalizar o exportar >
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, o NUmero del L, Fecha de
Titulo del procedimiento procedimiento Version realizacion
4 . . 8-10-2007
RECOPILAR INFORMACION 1.1 1.0
DE DISENO Utilizacién
Recopilar informacion sobre
materiales, dimensionamiento

general, condiciones de velocidad,
posicion o aceleracion, fuerzas
externas, etc.

Objetivo:

Tener la informacion necesaria para la realizacion del modelo virtual del mecanismo,
de tal manera que, el resulta final esté de acuerdo al planteamiento de disefno
requerido.

Descripcion:
La informacién que resulta ser util en las diferentes partes del proceso es:

Determinar tipo de eslabonamiento y tipo de uniones a realizar.
Realizar sketch a mano con el dimensionamiento basico del mecanismo.
Dimensionar y comprobar condicién de Grashof

Definir posicién y velocidad iniciales.

Definir un sistema de medidas congruente

Definir posicion de fuerzas externas.

ouhwNE=

Recomendaciones:
Crear proyecto de trabajo.

Realizar un sketch inicial representando los eslabones como lineas. Agregar
dimensiones y restricciones de sketch. Parametrizar las dimensiones y exportar los
parametros para que puedan ser utilizados en la creacion de eslabonamientos que
se adaptan a nuevos valores de longitud, de una manera automatizada.

Realizado por: Para uso exclusivo de: pagina

DIEGO ZAPAROLLI 1/1
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Titulo del procedimiento prNoucr:;ﬁigr?lo Version rz(ae(lzizgc(ijc')en
MODELAR CADA UNO DE LOS 1.2 1.0 §-10-2007
ESLABONES Utilizacion

Objetivo:

Crear cada uno los eslabones del mecanismo utilizando el moédulo de partes de

Inventor Professional 2008.

Diagrama de procedimiento:

utilizados
ensamblaje

Los modelos de cada eslabon seran

realizar el

Crear nuevo
archivo *.ipt
(1.2.1)

Hacer sketch
(1.2.2)

v

Aplicar
“Features”
(1.2.3)

Hay cambios

No

Aplicar
Propiedades
(1.2.4)

4><Guardar cambios>

Realizado por:

Para uso exclusivo de:

pagina

DIEGO ZAPAROLLI

1/1
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Titulo del procedimiento Nlﬁlme.ro.del Versién Fecha de
procedimiento realizacion
ENSAMBLAR CONJUNTO DE 1.3 1.0 8-10-2007
ESLABONES Utilizacién

Objetivo:

resultante  se
analisis de

El  ensamblaje
utilizaréa para el
simulacion dinamica.

Colocar los diferentes eslabones en su posicidon para formar un mecanismo

articulado.

Diagrama de procedimiento:

Crear nuevo
archivo *.iam
(1.3.1)

4>

Colocar
eslabon fijo
(1.3.2)

Colocar
eslabones
moviles
(1.3.3)

Aplicar
restricciones
de ensamble

(1.3.4)

Si

Errores en la
aplicacion de
restricciones

Guardar cambios>

Realizado por:

Para uso exclusivo de:

pagina

DIEGO ZAPAROLLI

1/1
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Titulo del procedimiento Nlﬁlme.ro.del Version Fegha (.j,e
procedimiento realizacion
REALIZAR ANALISIS EN 1.4 1.0 8-10-2007
SIMULACION DINAMICA Utilizacién Se utilizara este moddulo para
realizar analisis cinematico vy

cinético de mecanismos, definir
condiciones de operacion, y
obtener las graficas de posicion,
velocidad y aceleracion de cuerpos
rigidos y particulas.

Objetivo:

Introducir las condiciones de operacidon del mecanismo y obtener resultados para el
analisis cinematico y dindmico de mecanismos.

Diagrama de procedimiento:

Activar Introducir
S|r_nulla(;|on > conc_huone_:s de
dinamica funcionamiento

(1.4.1) (1.4.2)

Analizar
> puntos de
interés (1.4.3)

Se
desea analizar
otros puntos
de interés

Si Guardar cambios

0 exportar (1.4.4)

Realizado por: Para uso exclusivo de: pagina

DIEGO ZAPAROLLI 1/1
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Titulo del procedimiento Numero del Versién Fecha de
procedimiento realizacion
CREAR NUEVO ARCHIVO DE | 1:2:1 1.0 8-10-2007
PARTE (.IPT) o
Utilizacién
Creacion de sketch y features de

eslabones con el dimensionamiento
deseado.

Objetivo:

Crear un archivo para modelado tridimensional del eslabon.

Procedimiento:

Iniciar Inventor Professional 2008, en Start>All Programs>Autodesk>Inventor
2008>Inventor Professional 2008, o presionar icono desde el Desktop de Windows.

1.

2.

Presionar el botdn “Projects” para crear nuevo proyecto; la ubicacidon por
default es My Documents>Inventor

Introducir nombre al proyecto; por ejemplo, “Mecanismo de linea Recta de
Watt”, presionar “Next”, presionar “Finish”, aparecera el cuadro de dialogo
referente a la creacién de una ubicacion especifica del proyecto, presionar
“Yes”. Retornara al cuadro de didlogo que muestra el listado de proyectos,
asegurese que esta en el proyecto creado y presione el boton “Done”.
Retornara al cuadro de didlogo “Open”, presione ESC y expanda el menu
Tools>Application Options; seleccione la pestafia “Part” y elija la opcion
“Sketch on X-Z Plane”, esto permitira que los eslabones estén orientados en
la vista frontal, respecto a una vista SurEste.

Expanda el menu File>New, y elija entre las pestafias el sistema de
unidades en que desea trabajar, las opciones son: “English, Metric o
Professional”; esta ultima opcion permite seleccionar entre otras normas,
tales como: DIN, JIS, BS, etcétera. Seleccione el tipo de documento
mostrado como standard (mm).ipt. Presione OK.

Luego presione F6 para activar la vista isométrica, expanda el menu
View>Look_at, y presione el sketchl para alinear la vista al sketch.

A sugerencia, trace la vista lateral del eslabonamiento segin el perfil del
eslabonamiento, apoyado por las herramientas de dibujo de sketch, finalice
el sketch y seleccione la opcion “Extrude” para darle profundidad al perfil del
eslabonamiento, luego agregue la operacién “Hole” para hacer los agujeros
del pasador en los extremos del eslabon.

Presione F6, para ver pieza terminada, guarde el archivo en la ubicacion por
“default”, para que esté relacionada al proyecto anteriormente creada. Para
ver el procedimiento de dibujo en detalle, ver ejemplos en este documento.

Realizado por: Para uso exclusivo de: pagina
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Titulo del procedimiento Nume.ro.del Version Feqha (.j,e
procedimiento realizacion
1.2.2 1.0 8-10-2007
HACER SKETCH
Utilizacién .
El sketch es el primer paso para

crear una pieza, en sketch se
realiza en un plano de trabajo y
luego de haberlo creado se realizan

operaciones sobre el mismo
(Features)
Objetivo:
Mostrar cémo se realizaria un sketch para una manivela.
Procedimiento:
Pt 100——F=

[ 100———F=

Trazar un rectédngulo con
las proporciones sugeridas
en la ilustracion

Presionar la letra “D” para
activar la acotacion,
cambiar el valor de la cota
por los mostrados en la
ilustracion

Hacer dos circulos en las
posiciones mostradas en la
ilustracion, Presionar la
letra S para finalizar el
Sketch.

El resultado final es el perfil de un eslabonamiento, en este caso una manivela.

Realizado por:

Para uso exclusivo de:

pagina
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Titulo del procedimiento Nume.ro.del Version Fec_ha c.J,e

procedimiento realizacion
1.2.3 1.0 8-10-2007

APLICAR “"FEATURES"”
Utilizacién
Una vez creado el sketch, se
agregaran las operaciones de
extrusiéon y agujero para crear el
cuerpo rigido y definir los agujeros.
Objetivo:

Mostrar cdmo se realizaria una manivela a partir de un sketch ya creado.

Procedimiento:

Presionar la letra “E” y|Presionar F6 para ver la|Repetir el comando de
seleccionar todas las areas|vista isométrica de lajagujero para el otro
que encierra el sketch,|pieza, presionar la letrajextremo de Ila pieza.
agregar el valor de|“H” para hacer agujero Guardar el archivo con

con didmetro 12mm nombre manivela.ipt

profundidad (5mm)

El resultado final es un cuerpo rigido con propiedades de material de acero, con
masa, volumen y mddulos inerciales.

Realizado por: Para uso exclusivo de: pagina
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Objetivo:

Procedimiento:

Titulo del procedimiento Numero del Versién Fecha de
procedimiento realizacion
1.2.4 1.0 8-10-2007
APLICAR PROPIEDADES
Utilizacién

La pieza puede tener propiedades
reales

Asignar propiedades de material a la pieza creada.

Part2 Properties

General || Summary | Project | Status || Custom | Save |PhY5iCﬂ||

Material

|Steel b |

Density Requested Accuracy [W
| 7.850 gfam*3 | [Low v

General Properties

Inertial Properties

Mass | 0,082 kg (Relative |
Area | 5867.080 mm~2 (R
Volume | 10439.823 mm~3 {

Center of Gravity

¥ | -111.158 mm (Relz’
¥ | 2,500 mm {Relative
= Z | 34.080 mm (Relativ

[ Principal ]

[ clobal |

Principal Moments

It [3.016kgmm~2|

12 [82.356 kg nm?|

13 [79.682kgmm*|

Rotation to Principal

Rx | 0.00 deg (Relat|

Ry | 0.00 deg (Relat|

Rz | 0.00 deg (Relat|

Center Of Gravity

Close

Area superficial y Volumen.

Las propiedades calculadas son: Centro de Gravedad, Momentos de Inercia, Masa,

Realizado por:

Para uso exclusivo de:
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Titulo del procedimiento Nume.ro.del Version Feqha (.j,e

procedimiento realizacion
3. . 8-10-2007

CREAR NUEVO ARCHIVO 1.3.1 1.0
*. IAM Utilizacién
Una vez creadas todos Ilos
eslabones se lleva a cabo el
ensamble de cada uno de los
componentes.

Objetivo:
Obtener un mecanismo articulado con los eslabones creados anteriormente.
Procedimiento:

Expanda el menu File>New, y elija entre las pestaias el sistema de unidades que
utilizoé para la creacidon de partes. Seleccione el tipo de documento mostrado como
standard (mm).iam Presione OK.

Luego presione F6 para activar la vista isométrica. Ahora esta listo para colocar el
primer eslabdn del mecanismo.

Informacion adicional:

El modulo de ensamble contiene diversas herramientas utilizadas en el disefio de
maquinaria, por ejemplo:

Disefio de ejes y componentes de ejes
Disefio de engranes rectos, cénicos y de gusano
Conexidn por pernos

Calculo de cojinetes

Calculo de poleas

Calculo de resortes

Calculo de tornillos de potencia

Viga y columna

Frenos de tambor, disco y faja

10. Generador de estructuras metalicas

11. Enrutamiento de tuberia

12. Enrutamiento de conexiones flexibles.

13. Andlisis de Interferencia de partes moviles

OONOUT AWM=

Realizado por: Para uso exclusivo de: pagina
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Titulo del procedimiento Nlﬁlme.ro.del Version Feqha (.j,e
procedimiento realizacion
i 1.3.2 1.0 8-10-2007
COLOCAR ESLABON FI1IJO
Utilizacién

Objetivo:

Definir el eslabonamiento fijo dentro del mecanismo.

Procedimiento:

Seleccione la letra P (Place Component); en el cuadro de didlogo mostrado, busque
el archivo *.ipt que funcionara como el eslabonamiento fijo, presione OK, ubique la
pieza en alguna posicién y presione ESC.

En el “Browser Bar”, posicionarse sobre la parte colocada, presionar click del lado

El primer eslabon que se coloca en
el ensamblaje tiene la propiedad
de ser fijo (ésta condicion puede
cambiar a criterio del disefiador)

derecho y observar que tiene activada la opcién “Grounded”.

== 30

100 12.5
ko 304
S o
f}"" f!iﬁﬂ
=} 250 ==
Realizado por: Para uso exclusivo de: pagina
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Titulo del procedimiento Numero del Versién Fecha de
procedimiento realizacion
COLOCAR ESLABONES 1.3.3 1.0 8-10-2007

MéVILES Utilizacién

Los eslabones moviles se colocaran
sobre el espacio de ensamble para
luego iniciar con el proceso de
ensamble.

Objetivo:

Colocar sobre el espacio de trabajo todos los eslabones a utilizar.

Procedimiento:

Seleccione la letra P (Place Component); en el cuadro de didlogo mostrado, busque
el archivo *.ipt que funcionara como eslabonamiento movil, presione OK, ubique la

pieza en alguna posicidon y presione ESC. Repita el procedimiento para los otros
eslabones.

Realizado por: Para uso exclusivo de: pagina
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Titulo del procedimiento Nume.ro.del Version Fec_ha c.j,e
procedimiento realizacion
APLICAR RESTRICCIONES DE  1:3:4 1.0 8-10-2007
ENSAMBLE Utilizacién
Objetivo: El ensamble serd un mecanismo
cuando se le hayan afiadido

Restringir el movimiento relativo entre

eslabones

Procedimiento:

restricciones al movimiento relativo
entre piezas.

Presionar “C” para afiadir
restricciones y seleccionar
la restriccion de eje
concéntrico y cara con
cara para restringir la
manivela al eslabdn fijo.

Afadir el mismo tipo de
restricciones del paso
anterior entre la manivela
y el acoplador

Afadir el mismo tipo de
restricciones  del paso
anterior entre la acoplador
y el balancin

Afadir el mismo tipo de
restricciones  del paso
anterior entre la acoplador
y el balancin

Ahora el ensamblaje es un
mecanismo articulado.

Realizar la operacion “Drag
and Drop” con el “"mouse”
y girar la manivela.

Actualizar las propiedades de sketch.

Realizado por:

Para uso exclusivo de:

pagina
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Titulo del procedimiento Numero del Versién Fecha de
procedimiento realizacion
ACTIVAR SIMULACION 1.4.1 1.0 8-10-2007

DINAMICA Utilizacion

Permite acceder a las funciones del
maddulo de simulacién dinamica.

Objetivo:
Activar el modulo de simulacion dinamica.
Procedimiento:

Busque en el menu principal “Applications>Dynamic Simulation” para activar el
modulo de simulacién dindmica.

Dynamic Simulation ~ 2] El flujo de trabajo para utilizar la

_ 2 simulacion dinamica es:

Q Insert Joint

%{;FDFEE 1. Un conjunto de partes rigidas
que tengan articulaciéon entre si.

Q Torque 2. Crear uniones acordes al tipo de

"= Trace cadena cinematica que se desea
analizar.

N 3. Definir factores generales, como

\.1# la gravedad, la friccién, si su
movimiento depende de la

I Output Grapher accion de un motor, y otras
fuerzas externas.

JK Dynamic Part Mation 4. Usar las gréficas para visualizar

%uf Creste AVI Animation los datos de salida, tales como
fuerzas que se reciben, fuerzas

E Export to FEA transmitidas, momentos, par,

% Unknown Farce aceleraciones, velocidades y
posiciones.

Diymamic Simulation Settings 5. Exportar los resultados a un
analisis de elementos finitos

j‘; Farameters, . para evaluar la resistencia de

W materiales.

Cuando se han aplicado restricciones
estandar en el modo ensamblaje, al activar el modo simulacién dindmica son
reconocidas automaticamente como uniones estandar.

Realizado por: Para uso exclusivo de: pagina
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Titulo del procedimiento Numero del Versién Fecha de
procedimiento realizacion
ACTIVAR SIMULACION 1.4.1 1.0 8-10-2007
DINAMICA Utilizacién

=

% ensamble de mecanismo cero
o Grounded
f.'g Mabile Groups
Q Standard Joints
=& " External Loads
5 Gravity _

-3

"o Traces v

n mm

Simulation Panel 2]

Q[

|Looos | |10 |

0,00 s 0% 00:00:00

Trace:

Permite acceder a las funciones del
maddulo de simulacién dinamica.

El menu de Simulacidon Dindmica se
compone de:

Insert Joint: Herramienta para insertar
uniones estandar y no estandar.

Force: Aplicar alguna magnitud y
direccidon de fuerza constante o variable a
cualquier cuerpo rigido para que al hacer
el anélisis se tome en consideracidon sus
efectos.

Par: Aplicar magnitud y direccion de par
en cualquier cuerpo rigido para que al
hacer el andlisis se tome en consideracion
sus efectos.

Seleccionar cualquier punto dentro del ensamblaje a ser estudiado por las

leyes de la cinematica, posicion, velocidad o aceleracion.

Output Grapher: Permite visualizar las variables de interés, de manera individual o
simultaneamente entre eslabones o puntos seleccionados de una manera grafica

que depende del tiempo.

Realizado por:

Para uso exclusivo de: pagina
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Titulo del procedimiento Nlﬁlme.ro.del Version Fec_ha c.j,e
procedimiento realizacion
4. . -10-2007
INTRODUCIR CONDICIONES | 1-4-2 1.0 | 8-10-200
DE FUNCIONAMIENTO Utilizacion
Permite visualizar variables de
posiciéon, velocidad, aceleracion,
fuerza motriz, fuerza
=
Dynamic Simulation %) Las condiciones de operacién del

% enzamble de mecanismo cero
=) Grounded
@ n°1 :fijo:1
= f.'g Mabile Groups
@ n°2 :manivela:1
@ n*=3 :balancin: 1
@ n*4 ;acoplador: 1
=] Q Standard Joints
ﬂ n*1 :Revolution (manivela: 1, fijo: 1)
Q n®2 :Revolution (balandn: 1, fijo:1)
Q n*=3 :Revolution (acopladar: 1, maniv
Q n*4 :Point-Line (acoplador: 1, baland
=& " External Loads
) Gravity
e Traces
&l Export to FEA

De esta manera se introducen la
condiciones de funcionamiento. Asi
también pueden agregarse condiciones
de fuerza, par, posicion, friccion,
amortiguamiento, siempre y cuando
sea congruente con el disefio en
general.

mecanismo se introducen dependiendo de
la naturaleza del mecanismo. Para un
mecanismo manivela-balancin de un grado
de libertad, con la manivela conectada a
un motor que le transmite un determinado

par, las condiciones iniciales pueden
definirse, presionando click del lado
derecho del “mouse” sobre la unidn
manivela:1, fijo:1, y seleccionando

“Properties”; la pantalla que despliega es
la siguiente:

n° 1 :Revolution (manivela: 1, fijo:1)

General | dof 1(R) |

E ¥ ¥

90 deg

Velocity:

180,000 rpm [ computed

Value: Stiffness:

Clan. | | | | | |
Owax. | | | | | |

Bounds
Damping:

H Cancel ]

[ o

Realizado por:

Para uso exclusivo de: pagina
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Titulo del procedimiento Numero del Versién Fecha de
procedimiento realizacion
ANALIZAR PUNTOS DE 1.4.3 1.0 8-10-2007
INTERES Utilizacién

Permite visualizar variables

fuerza motriz, fuerza

de

posiciéon, velocidad, aceleracion,

Cada eslabonamiento puede ser analizado en diferentes graficas de posicion,
velocidad, aceleracion, fuerzas, pares, respecto al tiempo. La informacion puede
analizarse buscando puntos maximos y minimos dentro de la curva o simplemente
por observacion. resultados se muestran en este grafica que se actualiza con el
movimiento del mecanismo.

v Oan mula t aohe
=B & B E

ensamble de mecanismo cero E Time {5 ) W Ukin[1.1] {M.mm) L

g n®1:Revolution (manivela: || 0  +2.400008-01 +4,37162E402

(L1 Positions O +z2.50000E-01 +3.75056E 402

D Velocities O +2.600008-01 +2,25852E+02

D Accelerations O  +2.70000E-01 +3,29797E+01

223 Driving force O +z.z0000E-01 -2,83300E+01 :
B Ukin[1.1] Do onomoe s B _

([ Force E 03

(2 Moment 1.000

Q n®2 ;Revolution {(balancin: 1
Q n®3 :Revolution {(acoplador
Q n*4 :Foint-Line (acoplador:
(27 User varizbles

@ Time Steps -, 500

0.500

0.000

-1.000

-1.500

0.00 0.50 1.00 1.50 .00 2,50

< > Time |E-01

En esta grafica se muestra la fuerza motriz necesaria para mover el mecanismo
deseado a 180rpm, si se desea velocidad constante y aceleracién nula. Esta
informacidn seria util para dimensionar contrapesos o volantes, de tal manera de
lograr una fuerza mas constante.

Realizado por: Para uso exclusivo de: pagina
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Titulo del procedimiento Numero del Version Fecha de
procedimiento realizacion
GUARDAR CAMBIOS O 1.4.4 1.0 8-10-2007
EXPORTAR Utilizacién

Exportar los datos de simulacién
hacia el mddulo de célculo por
elementos finitos FEA.

La informacién que resulte del analisis puede servir para calcular la deformacion en

piezas producto de las fuerzas que se aplican sobre el mecanismo.

A continuacién se muestra un mapa de colores de la deformacién resultado de
haber exportado las cargas en movimiento de la simulacién dindamica (Dynamic
Simulation) hacia el médulo de “analisis por elementos finitos” (FEA) para un pin

que une los eslabones manivela-acoplador.

Deformation

Type: Deformation
Unit: mm

Time: 1.0e-009
10/24/2007 2:23 PM

5.9785e-9 Max
5.3456e-9
4.7127e-9
4.079%e-9
|J 34479

2.8141e-9
2.1813e-9
1.5484e-0
9.1555e-10

2.826%e-10 Min

Realizado por:

Para uso exclusivo de:
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X. SIMULACION DINAMICA DE MECANISMOS
SELECCIONADOS

A. Limitaciones de la simulacion dinamica

Las herramientas de simulacién dinamica de la ayuda de Autodesk
Inventor guian al usuario en los pasos de concepciéon y desarrollo, y ayudan a
reducir el NOmero de prototipos. Sin embargo, debido a la hipdtesis utilizada
en la simulacién, sdélo proporcionan una aproximacién del comportamiento

que se produce en los mecanismos reales.

B. Alcances de la simulacion dinamica

e Preparar AIP2008 para que convierta automaticamente las
restricciones de coincidencia y de insercidon relevantes a uniones
estandar.

e Acceder a una amplia biblioteca de uniones de movimiento.

e Definir fuerzas y momentos externos.

e Crear simulaciones de movimiento basadas en la posicion, la
velocidad, la aceleraciéon y el par de torsion como funciones de tiempo
en las uniones, ademas de las cargas externas.

e Visualizar movimiento 3D mediante trazados.

e Exportar graficos de salida completos y diagramas a Microsoft® Excel.

e Transferir uniones dindamicas y estaticas, y fuerzas de inercia al analisis
de tension de Autodesk Inventor o a ANSYS WorkBench.

e Calcular la fuerza necesaria para mantener la simulacion dindmica en
un estado de equilibrio.

e Convertir restricciones de ensamblaje en uniones de movimiento.

e Utilizar la friccion, el amortiguamiento, la rigidez y la elasticidad como

funciones de tiempo para definir las uniones.



C. Maecanismo tipico de manivela-balancin

Material:
Dimensiones:

Condiciéon de Grashof:

Velocidad de giro:
Fuerzas que actuan:

Determinar:

Obtener:

Acero 1020 (Cold Rolled)
Centimetros
8+ 25 < 21 + 17, la condicion de Grashof

se cumple. El eslabdn que gira 360° es el

eslabon a=8cm, a 180° como punto inicial.

180rpm impuesta por un motor.

Fuerza por gravedad y fuerza motriz.

Las graficas de posicién, velocidad,
aceleracion y fuerza sobre las uniones de
eslabonamientos moviles.

La grafica del par motriz que se

necesita para impulsar la manivela a

velocidad constante.

46
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1. Vista del ensamble

2. Introduccion de condiciones iniciales

ensamble del mecanismo []suppress O entity

e Grounded (%) Components
*,*_. Mobile Groups Enfity

Q Standard Joints % 2 Direction

----- #‘g n®1 :Revolution {fijo: 1, manivela; 1)

Q n®2 :Revolution (fijo: 1, balancin: 1) Value:

Q n*=3 :Revolution (acoplador: 1, manivela: 1)

----- Q n=4 :Point-Line {balancin: 1, acoplador: 1)

& External Loads g[x]: 0.000 mm/s2
6 o afv]: 0,000 mm/s2

s Traces
"ﬁ‘g Export to FEA a[Z]: -3310.000 mmf¢

oK Cancel

Activar Dynamic Simulation. En “external loads”, ubicar “Gravity”,

Components

presionar con “mouse”, seleccionar “component” introducir la direcciéon de

gravedad hacia -Z, colocando el signo (-) previo a valor desplegado:
-9810mm/s?



48

JUYIUL ol e

mamic Part Maotion n° 1 :Revolution (fijo:1, manivela:1)

eate AV Animation General | dof 1 {R) |

84

1samble del mecanismo

» Grounded Enable imposed motion
b Mobile Groups
; Standard Joints Driving
ﬂ n®1 :Revolution (fijo: 1, manivela: 1) O Position
Q n®2 :Revolution (fijo! 1, balancin: 1) (& velocity 180,000 rpm >

Q n=3 :Revolution (acoplador: 1, manivela: 1)
Q n=4 :Point-Line (balancin: 1, acoplador: 1)
* External Loads
6 Gravity
» Traces
[ export to FEA

() Acceleration

[ Ok H Cancel ]

Presionar doble click sobre Eslabén Nol., presionar la pestafia DOF
1(R), seleccionar el botéon “Imposed Motion”, luego marcar la casilla “Enable
imposed motion”, seleccionar velocidad; constante e introduzca el valor de
180rpm, presionar OK. Ahora ya tiene aplicada una par motriz que le hace

avanzar a 180rpm. El valor de este par variara respecto del tiempo.
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3. Ver resultados en datos y graficas. Observe los datos de

posicion, velocidad y aceleracion de la manivela, ademas puede buscar el

valor mas alto de par motriz. Note que la velocidad es constante y la

aceleracion es nula.

2f | Time (s) M 1] (deg)
O -+o.00 +0.00
O +o0.01 +10.91
O +o.02 +21.32
O +o0.03 +32.73
O +o.04 +43.64
O +o0.0s 454,55
O +o0.0 +65.45
O +o07 +76.36
O +o0.08 +87.27
O +o.02 +98.13
O +0.w0 +102.0%
O +0.11 +120.00
O +0.12 +130.21
O +o.13 +141,82
O +0.14 +152,73
O +o0.i5 +163.64
O +o0.i6 +174.54
O +o0.17 +185.45
[ e +196.,36
O +0.19 +207.27
O +o0.z0 +218.138
O +o0.21 +220.09
O +o0.22 +240.00
O +o0.23 +250.91
O +0.24 4+251.82
O +0.25 4272.73
O +o0.2 +283.64
| +224,55
O +0.2: +305,45
O +o.22 +318.36
O +o.30 +327.27
O +0.31 +338.18
O +o0.3:2 +345,09
O +0.33 +360.,00

W v[i1] (degfs)

+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00
+1080.00

B z[1.1] (deg/s~2) M Ukin[1.1] {M.mm )

+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00

+199.62
+499,53
-58.46
-189.25
-255.03
-263.99
-238.90
-198.26
-152.67
-106.36
©2.25
-18.47
+25.70
+71.54
+119.81
+168.24
+211.31
+240.78

+248.62
+235.94
+202.94

+100.80 Search Min,
+40.72 Search 0
-21.02 Local
8L22 v Global

-135.07
174,43 Save Simulation

Delete
Unselect all Curves

-186.66
-154.98
57,35 Print...
+63.24
+173.89
+199.62

Sawve Values as...

Grapher Options
Curve Properties
Post-Processing 4
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las graficas correspondientes a posicién, velocidad,

Manivela: Posicion vrs. Tiempo

A continuacidon

aceleracion y par motriz.

Time ﬁ
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Manivela: Aceleracidon vrs. Tiempo
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Manivela: par motriz vrs. Tiempo
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Con la grafica anterior se puede calcular el area bajo la curva a través

de una integral numérica y el valor obtenido se utiliza para dimensionar un

volante que permita reducir la potencia del motor que impulse el mecanismo.

9 Para mas informacion consulte Diseflo de Maquinaria de Robert L. Norton, primera edicidn

en espaniol., pagina 543.
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Se puede anadir puntos de analisis en “Trace Path” para observar la
trayectoria del acoplador en diferentes puntos a lo largo del mismo. Notar

que en los puntos cercanos a la manivela, la trayectoria del acoplador se
asemeja al movimiento de rotacion pura.

También se puede obtener los resultados de las caracteristicas de
posicion, velocidad, aceleracién y fuerza de las uniones entre eslabones. Por
ejemplo, se muestran las graficas correspondientes a posicién, velocidad,

aceleracion y fuerza en la uniéon manivela-acoplador.

Unién manivela-acoplador: Posicion vrs. Tiempo
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Time ’ﬁ
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Unién manivela-acoplador: Velocidad vrs. Tiempo
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Unién manivela-acoplador: Aceleracion vrs. Tiempo
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Unién manivela-acoplador: Fuerza vrs. Tiempo
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Si necesita mas informacién sobre las curvas mostradas en las graficas

anteriores, presione click del lado derecho del “"mouse” sobre el listado de

datos y seleccione “Curve Properties”.
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Observe los valores minimos, maximo, promedio, mediana, desviacion

estandar y amplitud.

Dynamic Simulation - Properties

Curve Properties |

Yalues

Average :

+4.31
Median :
+4.84
Multiplier

|:| Active

(® On whole curve

Value :

(1 0n displayed area
Minimum : Maximum :
+1.09 +7.36
Standard deviation : Amplitude :
+1.71 +6.26
Color :




XI. CONCLUSIONES

La manera de resolver problemas en Inventor Professional 2008 es
similar a la manera de resolver problemas en un proceso de disefio real, lo
gue permite cierto grado de intuiciéon para primeros usuarios disefadores o
ingenieros mecanicos.

El analisis dinamico que resulta en Inventor Professional 2008 utiliza
condiciones de fuerzas, momentos y condiciones que estadn presentes en
situaciones reales.

La aplicacion de tecnologia CAD y la simulacion por computadora
permite ahorrar tiempo y recursos en la fabricacién de costosos prototipos.

Los procedimientos descritos en este trabajo y las caracteristicas de
Inventor Professional 2008 no eliminan en lo absoluto, la necesidad de que el
disenador se prepare en los conceptos fundamentales de mecanismos para
interpretar correctamente los resultados obtenidos del analisis. Un uso
inadecuado o ilégico del programa generara un error de la misma naturaleza.

Desarrollar y aplicar programas informaticos en la resolucion de
problemas de ingenieria permitira a los disefladores e ingenieros mecanicos
situarse en un nivel alto de competitividad, ya que este tipo de tecnologia es
actualmente parte fundamental en la metodologia de disefio de Ultima

generacién para maquinaria y productos de consumo
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XII. RECOMENDACIONES

Mantener actualizado el taller de CAD Avanzado con la ultima versién
de Inventor Professional y un equipo con las condiciones éptimas para su
funcionamiento adecuado.

Motivar la utilizacién de la tecnologia CAD en otros cursos y proyectos
universitarios, principalmente en el campo de la Ingenieria.

Adquirir un atlas de mecanismos para disposicion de los estudiantes
del departamento de ingenieria mecanica.

Realizar concursos de disefio de mecanismos de barras para motivar su
aplicacion y uso en tares especificas, con fines académicos y comerciales.

Comparar los resultados obtenidos del andlisis de simulacién dindmica
con los resultados tedricos esperados del calculo matematico.

Integrar esfuerzos de desarrollo de aplicaciones de software entre

estudiantes universitarios para ampliar la posibilidad de soluciones efectivas.
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